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SYSTEM REQUIREMENTS

For Mac users, MOJO requires OS 10.4.x or greater, a G4 1.4GHz  

or Intel Core Duo 1.66GHz or faster, a DVD drive, and 2GB of RAM.

For Windows users, MOJO requires Windows XP or Windows 

Vista or greater, a Pentium or Athlon 1.4GHz or faster, a DVD 

drive, and 2GB of RAM.

The library requires 15GB of disk space.

Vir2 Instruments strongly recommends 4GB RAM or more and an 

88-key controller in order to use MOJO to its fullest potential.
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UPDATING & AUTHORIZING

After installation, please make sure that you are fully updated to 

the most recent versions of the three components that make up 

the MOJO package: the library (which contains all the patch infor-

mation and programming), the engine (which is powered by 

Kontakt), and the authorizer (Service Center). It is possible that 

any of these components may have a more recent version than 

shipped in your physical package, so you should check for updates 

to each of these three. You can do this by visiting the vir2.com 

web site and checking the Support area.

After you’ve completed installation, MOJO will be working in demo 

mode, meaning it will only work for 30 minutes at a time. To fully 

authorize it, launch Service Center (found in the Applications folder 

on a Mac, or the Program Files folder on Windows) and follow its 

instructions. You will be prompted to enter your e-mail address 

and password that make up your Native Instruments account, or 

will be given an option to create an account if you don’t already 

have one. Once inside the Service Center, it will give you a list of 

all the Native Instruments and NI-powered products on your hard 

drive and give you the option to activate them. You are allowed to 

install and use MOJO on up to two computers simultaneously. 

Service Center will guide you through the process for either online 

(instant) activation, or offline activation.

INSTALLING

The installation of MOJO is two separate steps: the installation of 

the Kontakt engine, and the installation of the MOJO library.

Insert the installation disc into your computer, and you will see 

the installers for both components. It doesn’t matter which is in-

stalled first. Run each of the installers and they will guide you 

through the installation process.

The Kontakt installer will install the Kontakt engine, its standalone 

application, all of its plug-in versions, and the Service Center au-

thorizer program. We recommend the Easy Install and that the 

install locations for each component are left at their default 

settings.

The MOJO library is approximate 14GB in size, and its installer will 

prompt you for the location you wish to install it. It can be installed 

on any available hard drive. For speed reasons, we recommend it 

be installed on internal or eSATA drives. Firewire can also be ac-

ceptable. External USB drives may give somewhat less optimized 

performance. We also recommend 7200 or 10,000rpm drives re-

gardless of the interface used.
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Now at the tips of your fingers is the most 

versatile horn section in the world, MOJO: 

Horn Section, offering the most flexible 

and innovative approach to pop, funk, 

jazz, and big band horns ever created in a 

virtual instrument. Inspired by legendary 

groups like Tower of Power and the big 

bands of decades past, MOJO is capable 

of emulating everything from a sultry sax 

solo to a screaming full big band playing 

at the top of their lungs.

Pushing the boundaries of sampling and scripting technology far 

beyond traditional sample libraries, MOJO offers a simple but fea-

ture-packed interface. No need to decide in advance which 

articulation you want to play. Simply load the instrument, turn the 

Ensemble knob to specify how many players you want playing 

that instrument (from a soloist to a dectet) and begin controlling 

the instrument from the keyboard. RIght: Screenshot of Mojo’s Interface
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More than a dozen articulations are instantly loaded and intelli-

gently handled via performance features and keyswitches. Behind 

the scenes, a humanizing function, smart release layers, and cus-

tom legato and vibrato tools assist the player in reproducing the 

ultimate dimensions in realism. Crescendos and swells sync in-

stantly to host tempos and can be triggered in real time. Included 

in the instrument collection are: soprano, alto, tenor, and baritone 

saxophones, trumpet (open, muted, and piccolo), flugelhorn, 

trombone (open and muted), bass trombone, and clarinet.  

The articulation list varies for each instrument, but generally in-

cludes sustains, stabs, staccatos, trills, slurs, shakes, octave runs, 

rise to hits, falls (including four different lengths), doits, bends, 

stylistic riffs, special effects, and tempo-synced swells and cre-

scendos. All samples are recorded in 24-bit stereo using the finest 

preamps in the world, including a vintage Neve 1073 and a 

LaChapell Audio 992EG, and mics by AKG, Neumann, and Coles.
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HOW TO ACCESS THE MOJO LIBRARY FROM KONTAKT

MOJO ships as a Kontakt-powered library, and MOJO is opened 

from within Kontakt, which can be run either as a standalone ap-

plication, or as a plug-in hosted by any major sequencer on either 

Macintosh or Windows platforms. All these versions are installed 

by the Easy Install option of the installer.

Users who don’t own a sequencer, or would like to simply boot up 

and be able to play MOJO, can go to their Applications folder 

(Mac) or Program Files folder (Windows) to launch Native 

Instruments > Kontakt.

Users who wish to use MOJO for sequencing or recording, or wish 

to play it multitimbrally, should use it in plug-in mode within a 

host sequencer. Kontakt supports the VST, AudioUnit, and RTAS 

plug-in formats. Any host sequencer that supports these plug-in 

formats properly will be able to use Kontakt. Instructions vary 

slightly from sequencer to sequencer, but the general procedure 

is to instantiate Kontakt as a virtual instrument plug-in, then load  

a MOJO instrument in Kontakt, then route a MIDI track to Kontakt 

so it can be triggered and recorded. 

The following instructions will help standalone and plug-in users 

get up and running quickly with a basic track of MOJO.

06 MOJO/
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USING KONTAKT IN STANDALONE MODE

The standalone Kontakt application can be found in the 

Applications > Kontakt 3 folder for Mac users, or Program Files > 

Native Instruments > Kontakt 3 for Windows users.

After launching the Kontakt application for the first time, you will 

be presented with a dialog box to set up your audio and MIDI set-

tings. Settings will vary for each user according to the specific 

setup, but the important thing is to route the audio to a valid au-

dio device, and to set the buffer reasonably low for good latency 

performance. We recommend 256 samples or less. The lower the 

latency slider, the less latency (the split second between the physi-

cal playing of the note and the sound coming out of Kontakt) will 

be, but the harder the computer will have to work. Typical useful 

values range between 128 and 256, however very fast computers 

may be able to handle lower values, while very slow computers 

may need higher values. > [IMAGE 01]

The MIDI page of the Options dialog box must be configured in 

order to let Kontakt know which MIDI device(s) to respond to. 

Kontakt will respond to up to four MIDI input ports (A, B, C, and 

D), so we recommend you switch one MIDI source on to Port A, 

as shown in the graphic below. > [02]
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More detailed information on the setup options can be found in 

the accompanying Kontakt manual. Once you have completed 

Kontakt setup, jump ahead to the Getting Started with MOJO 

section below.

USING KONTAKT AS A VST PLUG-IN IN CUBASE AND NUENDO

Users of Steinberg’s Cubase or Nuendo sequencers can use 

Kontakt as a VST plug-in. These instructions have been prepared 

in Cubase 5, although Kontakt may also work in earlier versions if 

the computer meets the system requirements. Once the project is 

open, go to the Devices menu and choose VST Instruments > [01]

When the VST Instruments window appears, click in the first 

available slot in which “no instrument” is listed. > [02]

A popup menu will appear; choose Kontakt 3. Then, an alert box 

will appear asking if you want to create a MIDI track assigned to 

the Kontakt 3 plug-in. Click Create. > [03]

The Kontakt window will appear, and a MIDI track will be created, 

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

abled, it will send any incoming MIDI played on your controller 

into Kontakt. At this point, you can skip down in the instructions 

to the Getting Started With MOJO section below.
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09USING KONTAKT AS AN AUDIOUNIT PLUG-IN IN LOGIC PRO, 
LOGIC STUDIO, LOGIC EXPRESS, ETC.

Users of Apple’s Logic can use Kontakt as an AudioUnit plug-in. 

These instructions have been prepared in Logic Pro 8, although 

Kontakt may also work in earlier versions if the computer meets 

the system requirements.

Once inside your Logic project, go to the Track mini-menu (in the 

central area of your screen) and choose Track > New... > [04]

The New Tracks dialog box will appear. Make sure Soft-ware 

Instrument is selected, then click Create. > [05]

The new instrument track will be created. On the left side of the 

screen you will see the channel strip for that channel, including a 

fader, pan knob, and various insert slots. Locate the blank slot 

just below the letters “I/O” and above the output pair: > [06]

Click there, and a list of plug-ins will appear. Choose AU 

Instruments > Native Instruments > Kontakt 3 > Stereo. > [07]

The Kontakt window will appear, and a MIDI track will be created, 

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

abled, it will send any incoming MIDI played on your controller 

into Kontakt. At this point, you can skip down in the instructions 

to the Getting Started With MOJO section below.
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USING KONTAKT IN GARAGEBAND

Users of Apple’s GarageBand can use Kontakt as an AudioUnit 

plug-in. These instructions have been prepared in GarageBand 5 

(which shipped with iLife ‘09), although Kontakt may also work in 

earlier versions if the computer meets the system requirements.

Once inside your GarageBand project, go to the Track menu and 

choose New Track. > [01]

A window with three choices will appear. Choose Software 

Instrument, then click Choose. > [02]

On the right side of the interface, the Browse tab will be showing. 

Switch to the Edit tab. > [03]

The Sound Generator will default to Piano. Click Piano, and a pop-

up menu will appear. Choose Audio Unit Modules > Kontakt 3. > [04]

Note: GarageBand may default to inserting effects, such as a com-

pressor and a visual EQ on this track. This will color the sound. If 

you don’t want these effects used, you can remove them.

Once Kontakt 3 is selected, the icon will change to the AudioUnit 

icon (the ball with the sound waves radiating outward). Double-

click on the icon to bring up the Kontakt window. > [05]
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11The Kontakt window will appear, and a MIDI track will be created, 

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

abled, it will send any incoming MIDI played on your controller 

into Kontakt. At this point, you can skip down in the instructions 

to the Getting Started With MOJO section below.

USING KONTAKT AS AN RTAS PLUG-IN IN PRO TOOLS

Users of Digidesign’s Pro Tools (M-Powered, LE, or TDM) can use 

Kontakt as an RTAS plug-in. These instructions have been pre-

pared in Pro Tools 8, although Kontakt may also work in earlier 

versions if the computer meets the system requirements. Once 

the project is open, go to the Track menu and choose New... > [06]

In the dialog box that appears, choose the appropriate options, 

such as the following: create 1 new stereo Instrument Track in 

samples. Then click Create. > [07]

Go to the Mix window and look at the channel strip for the instru-

ment. At the very top is an area for Inserts A-E. Shown in > [08]

Click on the first of the five slots, and navigate through the popup 

menu to choose multichannel plug-in > Instrument > Kontakt 3. 

Shown in image > [09]
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The Kontakt window will appear. At this point, you can skip down 

in the instructions to the Getting Started With MOJO section.

USING KONTAKT AS AN AUDIOUNIT PLUG-IN IN DIGITAL 
PERFORMER

Users of MOTU’s Digital Performer can use Kontakt as an AudioUnit 

plug-in. These instructions have been prepared in Digital Performer 

6, although Kontakt may also work in earlier versions if the com-

puter meets the needed system requirements.

Once the project is open, go to the Project menu and choose Add 

Track > Add Instruments... > [01]

In the resulting dialog box, click on the Unassigned pulldown menu, 

and choose Native Instruments > Kontakt 3. You can also change 

the number of MIDI tracks to be added, if you know you will want 

to use more than one. > [02]

The Kontakt window will appear, and a MIDI track will be created, 

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

abled, it will send any incoming MIDI played on your controller 

into Kontakt. At this point, you can skip down in the instructions 

to the Getting Started With MOJO section below.

USING KONTAKT AS A VST OR AUDIOUNIT PLUG-IN IN 
ABLETON LIVE

Users of Ableton Live can use Kontakt as a VST or Audio-Unit 

plug-in, depending on the version. The functionality is the same. 

These instructions have been prepared in Live 7, although Kontakt 

may also work in earlier or later versions if the computer meets 

the system requirements.

Once the project is open, go to the left side and click on the third 

icon down to show the Plug-in Devices list, scroll to the Native 

Instruments folder and locate Kontakt 3: > [03]

Drag Kontakt 3 into the central area where the text “Drop Files 

and Devices Here” is shown.

The Kontakt interface will appear, and it will already be actively 

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

abled, it will send any incoming MIDI played on your controller 

into Kontakt. At this point, you can skip down in the instructions 

to the Getting Started With MOJO section below.
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USING KONTAKT AS A PLUG-IN IN ANOTHER HOST

There are too many host programs to cover here in detail, but any 

modern sequencer that properly supports the VST, AudioUnit, or 

RTAS standards should be able to use Kontakt properly, and load 

MOJO within it. Consult the manual for your specific host to find 

out how to instantiate the Kontakt virtual instrument.
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GETTING STARTED WITH MOJO

Once you’ve followed the instructions above to get Kontakt loaded 

in whichever mode you prefer, Kontakt’s inner workings are ex-

actly the same. On the left side of the Kontakt interface is a sidebar 

called the Browser, and it has six tabs across the top: Files, 

Libraries, Database, Monitor, Modules, and Auto. Click the Library 

tab to get started with MOJO. > [01]

The MOJO library will appear, with buttons to access Instruments, 

Multis, and other materials. Clicking on the Multis or Instruments 

button will reveal folders of loadable patches, which will be dis-

cussed in more detail below.

USING MOJO: THE CORE INSTRUMENTS

Let’s jump right in. MOJO is simultaneously designed to be very 

easy to use, and yet be almost infinitely tweakable. To accomplish 

this, much of its power is hidden below its surface. MOJO is built 

around the twelve core instruments, mentioned above. When any 

of the instruments are loaded, the interface looks like this, giving 

you access to the most central features, including displays to show 

you the currently active behaviors, and menus that lead to sub-

menus revealing more of MOJO’s power: The two visible knobs 

are called Players and Mode, and each will be discussed separately.M
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RIght: Screenshot of Mojo’s Interface



Players. MOJO is designed so that loading any instrument gives 

you instant access to both solo and section versions of that in-

strument. The Players knob can be adjusted from Solo (1 player) 

to up to 10 players. As you add players to the ensemble, MOJO 

employs a large number of techniques to create the ensemble.  

It spaces the players in the ensemble across the stereo field, tells 

them how in-tune (or out of tune) to play, and how much varia-

tion there should be within the ensemble. (All of these parameters 

can be adjusted and will be discussed later, in the Section menu.) 

The Players Knob can be controlled via external MIDI CC as well. 

This makes it easy, for example, to sequence a MIDI part featuring 

stacked trumpet section ensemble lines, then switch to a solo 

trumpet for a solo part, then back to the ensemble. Since this is 

controlled via MIDI CC, the instructions to alter the number of 

people in the section (and indeed, every parameter about the 

section’s behavior) can be written into the MIDI track, insuring 

perfect recall every time the sequence is played. The external 

MIDI CC which controls the players knob is CC#22. > [02]
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Mode. The Mode knob is a central knob to how each instrument 

operates. It has three settings: > [03 PREVIOUS PAGE]

Poly stands for polyphonic playing, meaning that multiple notes 

can be played simultaneously. MOJO has a very high polyphony 

limit, so if your computer has enough power, it can play a large 

number of notes simultaneously. Adding players via the Players 

knob also contributes to higher polyphony. 

Mono stands for monophonic playing. When in this mode, the  

instrument will only play one note at a time. If you play a single 

note on your keyboard, then hold it while you strike a second 

note, the first original note will stop playing, and only the second 

note will be heard.

Legato is similar to Mono in that only one note can be played at a 

time, however, when Legato mode is used, MOJO intelligently con-

nects the first note to the second, simulating a true legato style.

 

Display Areas. Below the Players and Mode knobs lie two dark  

areas which are used to display various important pieces of infor-

mation about what is being played. > [04 PREVIOUS PAGE] 

The Active Articulation display shows which articulation is cur-

rently in use. Available articulations vary from instrument to 

instrument, but generally include: sustains, staccatos, stabs, 

swells, crescendos, bends, runs, trills, and so on. Each articulation 

is triggered via a silent trigger key called a keyswitch. Keyswitches 

will be discussed later in this manual. This display is placed here 

as an aid to show you which articulation is currently active. 

The Active Release display shows which release articulation is cur-

rently in use. A release articulation is a sample that is triggered 

when a key is released (instead of the Active Articulation which is 

the articulation that is triggered when a key is pressed). MOJO 

features regular release layers (the sound of the player naturally 

stopping the note with their lips) as well as custom release layers 

such as falls of varying lengths, or slurs, and so on. Like Active 

Articulations, the various available release layers can be triggered 

via silent trigger keys called keyswitches. The display always 

shows you the currently active release layer.

SETUP MENU

The Setup menu contains several subpages of detailed control 

panels which can be used to modify the sound and behaviors  

of MOJO. > [05 PREVIOUS PAGE] 
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Vibrato. This page allows you to customize the behavior of the 

physically modeled vibrato, which is applied by moving the mod 

wheel (MIDI CC#1). When the mod wheel is at its minimum posi-

tion, no vibrato is added. As you move the mod wheel up, a 

modeled vibrato is applied to the dry sound. > [01]

The Menu (shown as “All-Purpose”) allows you to choose the char-

acter of vibrato to use. Note that each vibrato type only takes 

effect after raising the mod wheel (or CC#1); simply choosing the 

preset will not immediately cause any change to the sound. > [02]

The Vibrato Knob shows how much vibrato is being applied at the 

moment. It moves in real time to reflect the mod wheel or CC#1.

The V Speed Knob allows you to specify the speed of the vibrato. 

It defaults to a standardized speed that is universally useful, but 

slower speeds may offer better results for ballads, while faster 

speeds may offer better results for uptempo songs or quick playing.

Section. The Section page allows you to customize the character-

istics of the section. The settings on this page only affect the 

instruments when the Players knob is set to more than 1 player. 

Once there are two or more players in the ensemble, the Section 

parameters take effect and alter the way the section behaves. 

Section page shown in image > [03]

The Mode Menu lets you select between Mode 1 and Mode 2. 

Mode 1 uses less granular stretching and is better for more play-

ers, while Mode 2 uses more stretching but results in a fuller 

sound, and is better for less players. 

The Players Pulldown Menu reflects the number of players se-

lected by the Players knob. It also dictates the default number of 

players if the section is turned on via the keyswitch.

The S Spread Knob allows you to adjust the position of the play-

ers in the stereo field. A higher percentage means that players will 

be spread apart widely.

The S Depth Knob allows you to increase a random amount of 

timing difference between the players. Higher values will make 

the players play slightly less together.
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The S Detune Knob allows you to increase a random amount that 

players will be detuned from each other. Higher values will make 

the players play less in tune with each other.

The S Human(ize) Knob allows you to increase a random amount 

of velocity randomization. 

Each of the knobs in the Section page have been preset to all-

purpose values that work well for most situations.

Instrument. The Instrument page gives you several controls over 

the overall sound and behavior of the instrument. > [01]

The menu that defaults to Alternate A/B specifies how the engine 

uses or orders the alternate samples. Almost every sample in 

MOJO has been recorded with multiple takes (A and B) which are 

an integral part of its realism. Using this menu, samples can alter-

nate between A and B takes, or reverse (B and A), or only A, or 

only B. In general, the greatest realism is achieved with A/B or B/A.

The Character Menu gives seven choices between a standard 

character, and different shades of aggressive or mellow playing.

The Punch Knob adds additional attack to the beginning of each 

sample. More rhythmic playing may benefit from added punch, 

and attacks will sound crisper if this knob is turned up.

The Humanize Button governs an advanced series of behaviors 

that prevent the engine from using the same sample twice in a row, 

thus eliminating the infamous “machine gun” effect so common 

to older methods. The engine often uses adjacent samples as well 

as alternate takes and velocity layers to render as realistic a per-

formance as possible. It can be defeated by disabling this button.

The H Range Knob dictates how widely the Humanize engine 

may pull an adjacent sample from, and can be set from 1-4. 

Setting this knob higher will result in more randomness but a 

greater risk for an odd-sounding sample that might be pitch-

stretched from too far an interval.

The H Seed Knob gives the Humanize engine a virtually random 

start value, from 1000 to 5000. 

Legato. MOJO includes an extremely advanced legato engine de-

signed to facilitate realistic smooth legato playing. By default, 

MOJO is configured with parameters that result in an all-purpose 

optimum legato right out of the box, and is used anytime the 

Mode knob is set to Legato. These settings are normally enough 

for most legato applications. > [02]

For users who wish to manipulate the legato behavior in greater 

depth, we will explain the design here.

MOJO’s legato is actually three different legato modes which are M
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switched between according to certain criteria. In the screenshot 

above, each of the three legato mode’s characteristics can be al-

tered. X-Time controls crossfade time (the time in which two 

legato notes are crossfaded), and B-Time controls bend time (the 

time in which a pitch warp or glide from one legato note to the 

next takes place).

With the three Edit Legato Buttons, you can access more detailed 

behaviors for the three legato modes: adjusting the quality (lower 

quality results in lower CPU usage), and the parameters related to 

the pitch-bending of legato notes. If you select “cent” you can en-

ter how many cents the last note is bent towards the new note, 

and the new note will start with a small pitch offset closer to the 

old note, then it subtly bends towards its true pitch. > [03]

The Octave Factor multiplies this cent value according to the 

played interval, in other words, if you play an octave interval and 

you set the octave factor to 5, the pitch warp is five times stron-

ger. You can also select the interval settings which use the played 

interval to calculate the pitch warp, or use the glide settings 

which result in a full glide from each legato note to the next. Glide 

Up and Glide Down limit glides to only up- or only down-glides.

With Legato Rules > [04] you can tell the engine when each legato 

mode is used or not used. By default, legato mode 1 is triggered 

by slower playing (time differences of 500ms or more from one 

note to the next, and an interval of less than two half-steps), while 
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legato modes 2 and 3 are triggered by progressively faster playing. 

The combination of these factors allows MOJO to respond dynami-

cally to different styles of playing and produce realistic smooth 

legato renderings. Each legato mode can by bypassed in the 

Legato Rules page, in case you need to only use one legato, or if 

you prefer to use MIDI CC control to alter one legato in real time.

Pitchbend. The Pitchbend page controls how the pitch bend 

wheel behaves. When it is selected, a pulldown menu and a knob 

appear: 

The Mode Knob allows you to select between Mode 1 for standard 

pitch bend (which is the default) and Mode 2 which employs a 

more advanced formant-correcting algorithm for pitch bend 

(which only works in Solo or Legato mode). Formant-correct pitch 

bend uses more CPU and polyphony, but results in more realistic 

pitch bend. Mode 2 is particularly effective on the instruments 

that can naturally slide between pitches, like the Trombone and 

Bass Trombone.

The P Range Knob lets you set the maximum range of the pitch 

bend sweep (both above and below the source pitch). In Mode 1, 

the maximum is 12 half steps or semitones. In Mode 2, the maxi-

mum is 7 half steps or semitones.

Releases. MOJO includes extensive and intelligent release layers, 

which are samples of the sound of the instrument stopping a 

note, triggered when a MIDI key is released. The release layers 

contribute greatly to the realism of the instruments. The Releases 

page allows you control over how the release layers behave.

The Mode knob lets you choose between Mode 1, which only trig-

gers releases if no other key is pressed anymore, and Mode 2, 

which plays all release notes (except in Legato mode, in which 

case releases are not played within a legato phrase to facilitate 

proper smooth legato rendering.

The Volume Knob allows you to adjust the level of the release 

samples. In each instrument, this has already been preset to an 

appropriate level for the instrument.

Speed. The Speed menu governs the behavior of both swells and 

crescendo articulations for each instrument. Swells and crescen-

dos were recorded at two different lengths (long and short) for 

every instrument in MOJO, and have been specially designed to 

tempo-sync automatically. The engine will read the tempo that 

the host is playing at (and will even follow changing tempos), and 

will calculate the proper length for the swell. The Speed menu al-

lows you to preset the desired lengths of swells and crescendos  

in beats.

Four pulldown menus appear, allowing long crescendos and 

swells to be set from 2 beats to 18 beats, and short crescnedos 

and swells to be set from 1 beat to 9 beats.M
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There is some overlap between the ranges of the short and long 

articulations. For example, it is possible to set long crescendos to 

last 4 beats and short crescendos to also last 4 beats. MOJO will 

utilize a different set of samples for each, and will time-stretch the 

crescendos to fit the current tempo. Different tempos may result 

in better results using one method or the other.

EFFECTS TAB

The Effects tab provides access to nine built-in audio effects that 

can be applied to any MOJO instrument.

Each effect features an Active button that must be clicked (en-

abled) before it will process the audio.

EZRoom. EZRoom is an easy-to-use integrated convolution re-

verb included with MOJO, and provides a quick way to instantly 

place the horns into a new acoustic space.

The Ezroom Menu allows you to choose which impulse response 

to use. A large number of impulse responses have been provided 

as part of the library.

The Predelay Knob lets you specify a predelay time for the con-

volution in milliseconds.

Dry And Wet Knobs allow you to adjust the balance of the dry 

(unaffected) and wet (reverb) sound to taste.

The Equalizer is a 3-band equalizer and offers control over the 

frequency, bandwidth, and gain of each band. 

The Compressor takes the incoming audio signal, and attenuates 

any signal that crosses the threshold (which can be adjusted us-

ing the Threshold knob) by the ratio (which can be adjusted using 

the Ratio knob). In plain English, the Compressor makes loud sig-

nals a little softer, so that the dynamic range of the instrument is 

more limited, and therefore more listenable and more likely to sit 

in a mix well. In addition, once the Compressor limits the dynamic 

range, the overall level of the instrument can now be boosted (us-

ing the Output knob). Attack and Release knobs are also provided, 

which specify how fast the Compressor attenuates the signal and 

how long it takes for the Compressor to stop attenuating the sig-

nal after the signal goes below the threshold.

Saturation is an effect that adds density (saturation) to the 

sound. It has only one knob, Saturation. Raising this knob will 

make the sound thicker and fuller and somewhat louder.

Distortion adds overdriven, amp-style distortion to the sound. 

This is useful more as a special effect. Controls are provided for 

Drive (overall level of added distortion) and Damping (a dulling  

of the high frequencies as distortion is added).
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Chorus adds a thickening effect by doubling the signal and de-

tuning the copy. Controls are provided for Depth, Speed, and 

Phase.

Reverb adds natural room echo to the sound. It is different from 

EZRoom, which is a convolution reverb based on actual real sonic 

spaces. Controls are provided for Predelay, Size, Color, Damping, 

Pan (Stereo Width), and Return Volume.

 

Delay adds a time-based delay to the sound, and can be fed back 

into itself by engaging the Feedback parameter. Controls are pro-

vided for Delay Time (in milliseconds), Feedback, Damping, Pan 

(Stereo Width), & Return Volume.

Stereo allows you to control the overall stereo character of the in-

strument. The Spread knob allows for the increasing or decreasing 

of the stereo width, and the Pan knob allows for the overall pan-

ning of the instrument.

The Limiter is a brick-wall limiter, which is enabled by default. It at-

tenuates any signal that exceeds the maximum 0dB level. In Gain, 

Release, and Output controls are also provided. Turning the 

Output knob above 0dB will result in distortion.

OTHER PATCHES

Core Instruments Lite. These instruments function identically 

with their Core Instruments counterparts, except they use a frac-

tion of the number of samples of the full version. As a result, the 

playing and the humanizing will be less detailed, however, users 

who have limited amounts of RAM will be able to load more at 

once by using these Lite versions.

Ensembles. This folder offers various combinations of MOJO in-

struments, for example, Alto Sax, Tenor Sax, Trumpet, and 

Trombone all layered over each other. Only sustain and release ar-

ticulations are included in these instruments, making them ideal 

for quickly building large-sounding horn sections. Note that, due 

to the varying range of each instrument, different areas of the 

keyboard feature different overlaps between the instruments, 

with the extreme low and high notes sometimes covered by only 

one of the included instruments.

Riffs feature almost two thousand prerecorded riffs played across 

each of the instruments. They have been grouped by instrument, 

tempo, and key. 

Within each patch are anywhere from a few to dozens of riffs. 

Riffs are always mapped chromatically, starting at C2 (the C be-

low middle C). The interface in the Riffs instruments is different 

than the Core Instrument. > [01]M
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The Effects menu is available and works identically to the Core 

Instruments, but there is a Key knob allowing for the easy trans-

position of the riffs into other keys. The Key knob defaults to the 

key of the patch loaded (C Major in this example), and a pulldown 

menu allows the choice of two different transposition methods.

All riffs automatically sync to host or MasterKontrol tempo. This 

particular instrument, while recorded at 120bpm, will play back  

at whatever tempo the host sequencer or the Kontakt Master 

Kontrol is set to.

Note that both time-stretching (syncing) and transposing are done 

by Kontakt’s DSP, and they work best if the distance to stretch is 

smaller rather than larger. This example patch, which was recorded 

in C major at 120bpm, should sound fine if played back in C# major 

at 110bpm, but may sound strange if stretched to F# major and 

50bpm. The best rule of thumb is to try and use riffs patches that 

are as close as to the key and tempo that you need them to be.

Special Effects encompass various noises that the instruments 

can make, such as key clicks, unusual glissandi, and more. Several 

hundred samples are included across the instruments, and each 

loadable patch features the individual samples mapped chromati-

cally on the keyboard starting at C1 (two octaves below middle C).

Sustains Only contain the same twelve instruments as the Core 

Instruments, but remove all additional articulations apart from 

sustains and releases. They are much faster to load than the Core 

Instruments and use less RAM. They are useful for instances in 

which realism is less important than being able to simply orches-

trate horn parts.
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MOJO is an extremely complicated instrument, and without proper 

management, using it in a sequencing environment can be daunt-

ing. What follows is a list of tips that can make the use of MOJO 

much smoother.

TIP 01: At the beginning of each MIDI track that is triggering MOJO, 

write in the starting articulation keyswitch (e.g. sustain), the Players 

knob setting (solo or 2-10 players), and the Mode (poly, mono, or 

legato). This insures that every time you rewind your sequence to 

the beginning, the MOJO instrument will reset itself to the same 

starting point. The location of these keyswitches is different for 

each instrument in MOJO, therefore, you will save time by initially 

writing these “reset” commands at the beginning of the sequence 

so that MOJO can be reset at any time. 

TIP 02: If you would like to sequence multiple solo lines of the 

same instrument (for example, four alto sax parts all playing le-

gato), you can load up four instances of the Alto Sax instrument. 

This is useful if you require fluid legato playing for each of the 

four voices. Because all four instances are using the same set of 

core samples, the same amount of RAM is used whether you are 

running four Alto Sax instances or one.
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TIP 03: Combining the previous two tips, if you have multiple in-

stances of the same instrument, you can insert the reset com- 

mands for one instance, then copy and paste to the other three.

TIP 04: If you are writing large ensemble horns (e.g. big band 

style), you can get more realistic acoustic results by narrowing 

the stereo field of the individual instruments (Setup > Section >  

S Spread and S Depth, and/or Effects > Stereo > Spread), then 

panning the overall instrument to a specific location in the stereo 

field. If you don’t apply this technique, then all instruments will 

appear to be located everywhere in the stereo field, which makes 

for a nice fat sound but is not the way a true ensemble would 

sound unless recorded from a great distance. Experiment with 

stereo placement to get the results you want.

TIP 05: When sequencing very short notes, experiment not just 

with staccato and stab articulations, but also with sustain and 

bend down articulations played very short. The playing style is 

very different for each. Sustains and bend downs played short tend 

to be more pitched and fit well in a section, while staccatos and 

stabs tend to have more bite, aggressiveness, and are the exclama-

tion mark of the articulations. Try each of these articulations to 

find the best fit for the passage of music being worked on.

TIP 06: If you are using a release articulation (e.g. a fall) following 

a staccato or stab articulation, note that the fall will trigger when 

the note is released, not when the sound of the staccato or stab 

finishes. Therefore, it’s crucial to adjust the location of the note-

off message (the end of the MIDI note) to coincide with where the 

fall should begin.

TIP 07: If you are sequencing fast big band music and need sloppy 

doubling, try loading multiple versions of each instrument, then 

try setting each instance to different articulations, such as sustain, 

bend down, stab, and staccato. While the stab and staccato artic-

ulations will be very short, the sustain and bend down articulations 

will provide the sustain, and the end result will be four players 

playing in very different styles.

TIP 08: Sections will often benefit from a constantly added very 

slight amount of vibrato. Since the vibrato is applied per player, it 

will add another human factor to the section.
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TECH SUPPORT

Vir2 Instruments stands behind its products and is committed to 

helping you get the most out of using them. Please check the 

Support area of the www.vir2.com web site if you encounter any 

difficulties in using the product. You may also e-mail support@

vir2.com. 

Before getting in touch with Vir2 Instruments regarding problems 

with the product, make sure you are running the latest versions of 

the library, engine, and Service Center. We are continuously up-

dating and improving the product, so it is possible that there are 

more recent updates available that were released after the physi-

cal manufacturing of your installation disc. 

THE FULL VERSION OF KONTAKT 3

MOJO ships with Kontakt 3 running in library mode, meaning it is 

fully able to play back the MOJO library and access the parame-

ters detailed in this manual. 

Registered owners of MOJO are eligible for a special crossgrade 

discount to the full version of Kontakt 3, which enables users to 

create their own libraries, import libraries in non-Kontakt formats, 
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and access numerous deep editing features. Visit the nativeinstru-

ments.com web site for details on the Kontakt crossgrade.

LICENSE AGREEMENT

The samples contained herein are licensed, not sold to you, the in-

dividual end user, by Vir2 Instruments. This non-exclusive, 

non-transferable license is granted only to the individual end user 

who has purchased an unopened, new, and lawfully made copy of 

this product from a dealer or distributor authorized by Vir2 

Instruments. All samples remain the property of Vir2 Instruments 

and are licensed only for use in the creation of a live or recorded 

performance that includes the licensed samples as part of a de-

rivative musical work created by the licensed end user. This 

license expressly forbids resale, rental, loan, gift, or transfer of 

these samples in any format or via any medium, except as part of 

a derivative musical work. The samples may not be included, 

whether unmodified or as part of a derivative work, in any sample 

library product. Any unlicensed usage will be prosecuted to the 

maximum extent possible under the law.
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